RI Series
Real-Time Operating System

Target Tool
RI78V4
RI850V4
RI850MP
RI600V4
RI600PX

All information contained in these materials, including products and product specifications, represents information on the product at the time of publication and is subject to change by Renesas Electronics Corp. without notice. Please review the latest information published by Renesas Electronics Corp. through various means, including the Renesas Electronics Corp. website (http://www.renesas.com).
Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as indicated below.

   “Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots etc.

   “High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.

Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and regulations and follow the procedures required by such laws and regulations.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
How to Use This Manual

Readers
This manual is intended for users who design and develop application systems using RL78 family, RH850 family RX family, V850 family, and 78K0R microcontrollers products.

Purpose
This manual is intended for users to understand the functions of real-time OS “RI Series” (RI78V4 V2.xx.xx, RI850V4 V2.xx.xx, RI600V4, RI600PX, RI850V4 V1.xx.xx, and RI850MP,RI78V4 V1.xx.xx ) manufactured by Renesas Electronics, described the organization listed below.

Organization
This manual consists of the following major sections.

CHAPTER 1  GENERAL
CHAPTER 2  FUNCTIONS
APPENDIX A  WINDOW REFERENCE

How to Read This Manual
It is assumed that the readers of this manual have general knowledge in the fields of electrical engineering, logic circuits, microcontrollers, C language, and assemblers.

To understand the hardware functions of the RL78 family, RH850 family, RX family, V850 family and 78K0R microcontrollers.
-> Refer to the User’s Manual of each product.

Conventions
Data significance: Higher digits on the left and lower digits on the right

Note: Footnote for item marked with Note in the text

Caution: Information requiring particular attention

Remark: Supplementary information

Numeric representation: Decimal ... XXXX
Hexadecimal ... 0xXXXX

Prefixes indicating power of 2 (address space and memory capacity):
K (kilo) \(2^{10} = 1024\)
M (mega) \(2^{20} = 1024^2\)
Related Documents

The related documents indicated in this publication may include preliminary versions. However, preliminary versions are not marked as such.

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Document No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>RI Series</td>
<td>Start: This manual</td>
</tr>
<tr>
<td></td>
<td>Message: R20UT0756E</td>
</tr>
<tr>
<td>RI850V4 V2.xx.xx</td>
<td>Coding: R20UT2889E</td>
</tr>
<tr>
<td></td>
<td>Debug: R20UT2890E</td>
</tr>
<tr>
<td></td>
<td>Analysis: R20UT2891E</td>
</tr>
<tr>
<td>RI600V4</td>
<td>Coding: R20UT0711E</td>
</tr>
<tr>
<td></td>
<td>Debug: R20UT0775E</td>
</tr>
<tr>
<td></td>
<td>Analysis: R20UT2185E</td>
</tr>
<tr>
<td>RI600PX</td>
<td>Coding: R20UT0964E</td>
</tr>
<tr>
<td></td>
<td>Debug: R20UT0950E</td>
</tr>
<tr>
<td>RI78V4 V2.xx.xx</td>
<td>Coding: R20UT3375E</td>
</tr>
<tr>
<td></td>
<td>Debug: R20UT3374E</td>
</tr>
<tr>
<td></td>
<td>Analysis: R20UT3373E</td>
</tr>
<tr>
<td>RI850V4</td>
<td>Coding: R20UT0515E</td>
</tr>
<tr>
<td></td>
<td>Debug: R20UT0754E</td>
</tr>
<tr>
<td></td>
<td>Analysis: R20UT0517E</td>
</tr>
<tr>
<td>RI850MP</td>
<td>Coding: R20UT0519E</td>
</tr>
<tr>
<td></td>
<td>Debug: R20UT0755E</td>
</tr>
<tr>
<td>RI78V4</td>
<td>Coding: R20UT0511E</td>
</tr>
<tr>
<td></td>
<td>Debug: R20UT0753E</td>
</tr>
<tr>
<td></td>
<td>Analysis: R20UT0513E</td>
</tr>
</tbody>
</table>

Caution

The related documents listed above are subject to change without notice. Be sure to use the latest edition of each document when designing.

All trademarks or registered trademarks in this document are the property of their respective owners.
TABLE OF CONTENTS

CHAPTER 1 GENERAL ... 6

1.1 Outline ... 6
   1.1.1 Real-time OS ... 6
   1.1.2 Multi-task OS ... 6

1.2 Features ... 7

1.3 Configuration ... 9
   1.3.1 RI78V4 V2.xx.xx ... 9
   1.3.2 RI850V4 V2.xx.xx ... 10
   1.3.3 RI600V4 ... 11
   1.3.4 RI600PX ... 12
   1.3.5 RI850V4 V1.xx.xx ... 13
   1.3.6 RI850MP ... 14
   1.3.7 RI78V4 V1.xx.xx ... 15

1.4 Folder Configuration ... 16
   1.4.1 RI78V4 V2.xx.xx ... 16
   1.4.2 RI850V4 V2.xx.xx ... 18
   1.4.3 RI600V4 ... 20
   1.4.4 RI600PX ... 21
   1.4.5 RI850V4 V1.xx.xx ... 22
   1.4.6 RI850MP ... 26
   1.4.7 RI78V4 V1.xx.xx ... 28

1.5 Execution Environment ... 30

CHAPTER 2 FUNCTIONS ... 33

2.1 Installing Real-time OS Package ... 33
2.2 Uninstalling Real-time OS Package ... 34
2.3 Create a Project for RI Series ... 35
2.4 Convert a CubeSuite Project into a CS+ Project ... 36
2.5 Convert a HEW Project into a CS+ Project ... 36
2.6 Convert a Project “RI78V4 V1.xx.xx -> V2.xx.xx” or “RI850V4 V1.xx.xx -> V2.xx.xx” ... 36
2.7 Start Resource Information Tool ... 37
2.8 Start Task Analyzer Tool [RI78V4 V2.xx.xx][RI850V4 V2.xx.xx][RI600V4] ... 39
2.9 Start Program Analyzer Tool [RI850V4 V1.xx.xx][RI78V4 V1.xx.xx] ... 41

APPENDIX A WINDOW REFERENCE ... 43

A.1 Description ... 43
CHAPTER 1 GENERAL

This chapter describes the outline of real-time OS "RI series" manufactured by Renesas Electronics.

1.1 Outline

The RI series is a built-in real-time, multi-task OS that provides a highly efficient real-time, multi-task environment to increases the application range of processor control units.

The RI series is a high-speed, compact OS capable of being stored in and run from the ROM of a target system.

1.1.1 Real-time OS

Control equipment demands systems that can rapidly respond to events occurring both internal and external to the equipment. Conventional systems have utilized simple interrupt handling as a means of satisfying this demand. As control equipment has become more powerful, however, it has proved difficult for systems to satisfy these requirements by means of simple interrupt handling alone.

In other words, the task of managing the order in which internal and external events are processed has become increasingly difficult as systems have increased in complexity and programs have become larger.

Real-time OS has been designed to overcome this problem.

The main purpose of a real-time OS is to respond to internal and external events rapidly and execute programs in the optimum order.

1.1.2 Multi-task OS

A "task" is the minimum unit in which a program can be executed by an OS. "Multi-task" is the name given to the mode of operation in which a single processor processes multiple tasks concurrently.

Actually, the processor can handle no more than one program (instruction) at a time. But, by switching the processor's attention to individual tasks on a regular basis (at a certain timing) it appears that the tasks are being processed simultaneously.

A multi-task OS enables the parallel processing of tasks by switching the tasks to be executed as determined by the system.

One important purpose of a multi-task OS is to improve the throughput of the overall system through the parallel processing of multiple tasks.
1.2 Features

The RI series has the following features.

(1) Conformity with μITRON4.0 specification
The RI series is designed as a typical built-in control OS architecture that conform to the μITRON4.0 specification.

(2) High versatility
To support various execution environments, the RI series extracts hardware-dependent processing that is required to execute processing as user-own coding modules and target-dependent modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well.

(3) Compact design
The RI series is a real-time, multi-task OS that has been designed on the assumption that it will be incorporated into the target system; it has been made as compact as possible to enable it to be loaded into a system's ROM. Since it is possible to link only those service calls that are used by the user within the system among the service calls provided by the RI series during system building, a real-time multitask OS that is ideally suited to the needs of the user while being compact can be built.

(4) Support tools related to real-time OS
The RI series provides tools that are useful during system building and system debugging.

(a) Configurator
Loads highly writable and readable system configuration files as input files, and outputs information files (system information table file, system information header file, etc.) as information files.


(b) Table generation utility [RI600PX]
Table generation utility provides the command line tool that by gathering the service call information used by an application, generates the service call and interrupt vector tables most suitable for the application.


(c) Resource information tool
Resource information tool provides functions for efficient system debugging (OS resource display function, etc.).


(d) Task analyzer tool [RI78V4 V2.xx.xx] [RI850V4 V2.xx.xx] [RI600V4]
The task analyzer tool receives trace information from a debugger and provides functions for graphically displaying analysis information on the status of execution transition of programs being processed, usage of real-time OS resources, usage of the CPU, etc..

(e) Program analyzer [RI850V4 V1.xx.xx] [RI78V4 V1.xx.xx]

System program analyzer provides functions for performing quantitative performance analysis on processing programs (analysis related to time such as bugs in processing timing or performance evaluation of entire system).


(5) Memory protection function [RI600PX]

(a) High-reliability system

To reduce a possibility of being unable to detect program glitches when debugging the program and causing a trouble in the market after the system has been shipped from the factory, this OS assures the system of high-reliability. If memory data destruction occurs especially in a memory area in which the OS, etc. are stored, the system may produce a dangerous condition by, for example, operating erratically. However, since RI600PX is free of memory data corruptions, the system can continue operating normally, and is therefore assured of high system reliability.

(b) Debug assistance

In systems without memory protection, a corruption of memory content by an illegal pointer behavior, etc. generally is not noticed until it actually comes to the surface as a trouble symptom. The cause of a bug can only be identified by analyzing emulator's trace data, which requires a large amount of time. The RI600PX can detect a bug when an illegal memory access is committed, enabling the debugging efficiency to be greatly increased.


(6) Support for programming for dual-core microcontrollers [RI850MP]

The RI series provides the service for achieving synchronization between processor elements (PEs) so as to control a dual-core microcontroller.

1.3 Configuration

The module construction of the RI series is as follows.

1.3.1 RI78V4 V2.xx.xx

The RI78V4 V2.xx.xx consists of the following two types of modules.

(1) Kernel

The kernel, which is the processing block that forms the core of the RI78V4 V2.xx.xx and the main processing block for the service calls provided by the RI78V4, provides the following functions.

- Task management functions
- Task dependent synchronization functions
- Synchronization and communication functions (Semaphores, eventflags, data queues, mailboxes)
- Memory pool management functions (Fixed-sized memory pools)
- Time management functions
- System state management functions
- Interrupt management functions
- System configuration management functions
- Scheduler

(2) User-own coding module

To support various execution environments, the RI78V4 V2.xx.xx extracts hardware-dependent processing that is required to execute processing as user-own coding modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well.

The following lists the user-own coding modules extracted for each function.

- Interrupt management functions (Interrupt entry processing)
- System configuration management functions (Boot processing, initialization routine)
- Scheduler (Idle routine)

Remark For interrupt handlers written by C language (defined the attribution “TA_HLNG” in interrupt handler definition “DEF_INH” in system configuration file), the user is not required to write the relevant interrupt entry processing because the C compiler automatically outputs the interrupt entry processing corresponding to the interrupt request name.

1.3.2 RI850V4 V2.xx.xx

The RI850V4 V2.xx.xx consists of the following modules.

(1) Kernel

The kernel, which is the processing block that forms the core of the RI850V4 V2.xx.xx and the main processing block for the service calls provided by the RI850V4, provides the following functions.

- Task management functions
- Task dependent synchronization functions
- Synchronization and communication functions (Semaphores, eventflags, data queues, mailboxes)
- Extended synchronization and communication functions (Mutexes)
- Memory pool management functions (Fixed-sized memory pools, variable-sized memory pools)
- Time management functions
- System state management functions
- Interrupt management functions
- Service call management functions
- System configuration management functions
- Scheduler
- System initialization functions

(2) User-own coding module

To support various execution environments, the RI850V4 V2.xx.xx extracts hardware-dependent processing that is required to execute processing as user-own coding modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well.

The following lists the user-own coding modules extracted for each function.

- Task management functions (Post-stack overflow processing)
- Interrupt management functions (Interrupt entry processing)
- System configuration management functions (CPU exception entry processing, initialization routine)
- Scheduler (Idle routine)
- System initialization routine (Boot processing)
- System initialization routine (System dependent information)

1.3.3 RI600V4

The RI600V4 consists of the following modules.

(1) Kernel

The kernel, which is the processing block that forms the core of the RI600V4 and the main processing block for the service calls provided by the RI600V4, provides the following functions.

- Task management functions
- Task dependent synchronization functions
- Synchronization and communication functions (Semaphores, eventflags, data queues, mailboxes)
- Extended synchronization and communication functions (Mutexes, message buffer)
- Memory pool management functions (Fixed-sized memory pools, variable-sized memory pools)
- Time management functions
- System state management functions
- Interrupt management functions
- System configuration management functions
- Object reset module
- Scheduler

(2) User-own coding module

To support various execution environments, the RI600V4 extracts hardware-dependent processing etc. that is required to execute processing as user-own coding modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well.

The following lists the user-own coding modules extracted for each function.

- System down (System down routine)
- System initializing process (Boot processing, section information)

1.3.4 RI600PX

The RI600PX consists of the following modules.

(1) Kernel

The kernel, which is the processing block that forms the core of the RI600PX and the main processing block for the service calls provided by the RI600PX, provides the following functions.

- Task management functions
- Task dependent synchronization functions
- Task exception handling functions
- Synchronization and communication functions (Semaphores, eventflags, data queues, mailboxes)
- Extended synchronization and communication functions (Mutexes, message buffer)
- Memory pool management functions (Fixed-sized memory pools, variable-sized memory pools)
- Time management functions
- System state management functions
- Interrupt management functions
- System configuration management functions
- Object reset module
- Memory object management functions
- Scheduler

(2) User-own coding module

To support various execution environments, the RI600PX extracts hardware-dependent processing etc. that is required to execute processing as user-own coding modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well.

The following lists the user-own coding modules extracted for each function.

- Memory protection functions (Access exception handler)
- Time management functions (Base clock timer initialization routine)
- System down (System down routine)
- System initializing process (Boot processing, section information)

1.3.5 RI850V4 V1.xx.xx

The RI850V4 V1.xx.xx consists of the following modules.

(1) Kernel

The kernel, which is the processing block that forms the core of the RI850V4 V1.xx.xx and the main processing block for the service calls provided by the RI850V4 V1.xx.xx, provides the following functions.

- Task management functions
- Task dependent synchronization functions
- Task exception handling functions
- Synchronization and communication functions (Semaphores, eventflags, data queues, mailboxes)
- Extended synchronization and communication functions (Mutexes)
- Memory pool management functions (Fixed-sized memory pools, variable-sized memory pools)
- Time management functions
- System state management functions
- Interrupt management functions
- Service call management functions
- System configuration management functions
- Scheduler

(2) Target-dependent module

To support various execution environments, the RI850V4 V1.xx.xx extracts hardware-dependent processing that is required to execute processing as target-dependent modules, and provides them as sample source files. This enhances portability for various execution environments and facilitates customization as well. The following lists the target-dependent modules extracted for each function.

- Interrupt management functions (Service call "dis_int", service call "ena_int", interrupt mask setting processing (overwrite setting), interrupt mask setting processing (OR setting), interrupt mask acquire processing)

(3) User-own coding module

To support various execution environments, the RI850V4 V1.xx.xx extracts hardware-dependent processing that is required to execute processing as user-own coding modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well. The following lists the user-own coding modules extracted for each function.

- Task management functions (Post-stack overflow processing)
- Interrupt management functions (Interrupt entry processing)
- System configuration management functions (CPU exception entry processing, initialization routine)
- Scheduler (Idle routine)
- System initialization routine (Boot processing)

1.3.6 RI850MP

The RI850MP consists of the following modules.

(1) Kernel

The kernel, which is the processing block that forms the core of the RI850MP and the main processing block for the service calls provided by the RI850MP, provides the following functions.

- Task management functions
- Task dependent synchronization functions
- Synchronization and communication functions (Semaphores, eventflags, data queues, mailboxes)
- Extended synchronization and communication functions (Mutexes)
- Memory pool management functions (Fixed-sized memory pools)
- Time management functions
- System state management functions
- Interrupt management functions
- System configuration management functions
- Scheduler

(2) Target-dependent module

To support various execution environments, the RI850MP extracts hardware-dependent processing that is required to execute processing as target-dependent modules, and provides them as sample source files. This enhances portability for various execution environments and facilitates customization as well.

The following lists the target-dependent modules extracted for each function.

- Interrupt management functions (Service call "dis_int", service call "ena_int", interrupt mask setting processing (overwrite setting), interrupt mask setting processing (OR setting), interrupt mask acquire processing)

(3) User-own coding module

To support various execution environments, the RI850MP extracts hardware-dependent processing that is required to execute processing as user-own coding modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well.

The following lists the user-own coding modules extracted for each function.

- Interrupt management functions (Interrupt entry processing)
- System configuration management functions (CPU exception entry processing, initialization routine)
- Scheduler (Idle routine)
- System initialization routine (Boot processing)

1.3.7 RI78V4 V1.xx.xx

The RI78V4 V1.xx.xx consists of the following modules.

(1) Kernel

The kernel, which is the processing block that forms the core of the RI78V4 V1.xx.xx and the main processing block for the service calls provided by the RI78V4 V1.xx.xx, provides the following functions.

- Task management functions
- Task dependent synchronization functions
- Synchronization and communication functions (Semaphores, eventflags, mailboxes)
- Memory pool management functions (Fixed-sized memory pools)
- Time management functions
- System state management functions
- Interrupt management functions
- System configuration management functions
- Scheduler

(2) User-own coding module

To support various execution environments, the RI78V4 extracts hardware-dependent processing that is required to execute processing as user-own coding modules, and provides it as sample source files. This enhances portability for various execution environments and facilitates customization as well.

The following lists the user-own coding modules extracted for each function.

- Interrupt management functions (Interrupt entry processing)
- System configuration management functions (Boot processing, initialization routine)
- Scheduler (Idle routine)

Remark: For interrupt handlers written using the #pragma rtos_interrupt directive, the user is not required to write the relevant interrupt entry processing because the C compiler automatically outputs the interrupt entry processing corresponding to the interrupt request name.

1.4 Folder Configuration

This section explains the folder configuration of the files read from the supply medium when RI series has been installed. The RI series is supplied in the form of an object release version or a source release version.

- Object release version (A file of executable format of real-time OS is supplied.)
- Source release version (To generate a library of real-time OS, a source file is supplied.)

1.4.1 RI78V4 V2.xx.xx

The following shows the folder configuration when the files stored in the RI78V4 V2.xx.xx distribution media have been installed.

Figure 1-1. Folder Configuration (Object Release Version) [RI78V4 V2.xx.xx]

```
Renesas Electronics\CS+\CC

Documents
Help
Plugins
  RtosBuild
  RtosControl
  RtosResource
  RtosTaskAnalyzer

RI78V4
  bin
  include
  library
    ri78_ccrl
    medium

SampleProjects

\rightarrow Documents
\rightarrow Online help file for the RI78V4 V2.xx.xx
\rightarrow Plug-in relation for CS+
\rightarrow Plug-in for real-time OS build setting
\rightarrow Plug-in for real-time OS analysis setting
\rightarrow Plug-in for real-time OS resource information display
\rightarrow Plug-in for task analyzer tool
\rightarrow RI78V4 V2.xx.xx kernel relation
\rightarrow Executable file of configurator
\rightarrow Header files for the RI78V4 V2.xx.xx
\rightarrow Library files for the RI78V4 V2.xx.xx
\rightarrow Library files for CC-RL compiler
\rightarrow Library files for medium memory model
\rightarrow Sample project folder for CS+
```
Figure 1-2. Folder Configuration (Source Release Version) [RI78V4 V2.xx.xx]

Renesas Electronics/CS+\CC

- Documents
- Help
- Plugins
  - RtosBuild
  - RtosControl
  - RtosResource
  - RtosTaskAnalyzer
- RI78V4
  - bin
  - include
  - library
    - rl78_ccrl
    - medium
  - source
    - kernel
    - project
      - rl78_ccrl
      - medium
- SampleProjects

- Documents
- Online help file for the RI78V4 V2.xx.xx
- Plug-in relation for CS+
- Plug-in for real-time OS build setting
- Plug-in for real-time OS analysis setting
- Plug-in for real-time OS resource information display
- Plug-in for task analyzer tool
- RI78V4 V2.xx.xx kernel relation
- Executable file of configurator
- Header files for the RI78V4 V2.xx.xx
- Library files for the RI78V4 V2.xx.xx
- Library files for CC-RL compiler
- Library files for medium memory model
- Folder containing the kernel source
- Kernel source files
- Project folder for kernel source building
- Project folder for CC-RL compiler
- Project folder for medium memory model
- Sample project folder for CS+
1.4.2 RI850V4 V2.xx.xx

The following shows the folder configuration when the files stored in the RI850V4 V2.xx.xx distribution media have been installed.

Figure 1-3. Folder Configuration (Object Release Version) [RI850V4 V2.xx.xx]
Figure 1-4. Folder Configuration (Source Release Version) [RI850V4 V2.xx.xx]

- **Renesas Electronics/CS+/CC**
  - Documents
  - Help
  - Plugins
    - RtosBuild
    - RtosControl
    - RtosResource
    - RtosTaskAnalyzer
  - RI850V4RH
    - Bin
    - Include
    - Library
      - rh850_ccrh
        - r32
        - rh850_ghs
        - r32
      - source
        - Kernel
        - Project
          - rh850_ccrh
            - r32
            - rh850_ghs
            - r32
          - Sample
            - SampleProjects

- **Plug-ins**
  - Documents
  - Online help file for RI850V4 V2.xx.xx
  - Plug-in relation for CS+
  - Plug-in for real-time OS build setting
  - Plug-in for real-time OS analysis setting
  - Plug-in for real-time OS resource information display
  - Plug-in for task analyzer tool
  - RI850V4 V2.xx.xx kernel relation
  - Executable file of configurator
  - Header files for RI850V4 V2.xx.xx
  - Library files for RI850V4 V2.xx.xx
  - Library files for CC-RH compiler
  - Library files for 32 register mode
  - Library files for Green Hills Compiler
  - Library files for 32 register mode
  - Folder containing the kernel source
  - Kernel source files
  - Project folder for kernel source building
  - Project folder for CC-RH compiler
  - Project folder for 32-register mode
  - Project folder for Green Hills Compiler
  - Project folder for 32-register mode
  - Sample project folder for Green Hills Software
  - Sample project folder for CS+
1.4.3 RI600V4

The following shows the folder configuration when the files stored in the RI600V4 distribution media have been installed.

**Figure 1-5. Folder Configuration (Object Release Version) [RI600V4]**

```
Renesis Electronics\CS+\ICC
  Documents
  Help
  RI600V4
    bin600
    inc600
    lib600
  Plugins
    RtosBuild
    RtosControl
    RtosResource
    RtosTaskAnalyzer
  SampleProjects
```

- **Documents**
  - Online help file for the RI600V4
  - RI600V4 kernel relation
  - Executable file of configurator / table generation utility
- **Help**
  - Header files for the RI600V4
  - Files of common definition macros of ITRON specifications
- **lib600**
  - Library files / template files for the RI600V4
- **Bin600**
- **inc600**
- **RI600V4 kernel relation**
  - Sample project folder for CS+

**Figure 1-6. Folder Configuration (Source Release Version) [RI600V4]**

```
Renesis Electronics\CS+\ICC
  Documents
  Help
  RI600V4
    bin600
    inc600
    lib600
    src600
  Plugins
    RtosBuild
    RtosControl
    RtosResource
    RtosTaskAnalyzer
  SampleProjects
```

- **Documents**
  - Online help file for the RI600V4
  - RI600V4 kernel relation
  - Executable file of configurator / table generation utility
- **Help**
  - Header files for the RI600V4
  - Files of common definition macros of ITRON specifications
- **lib600**
  - Library files / template files for the RI600V4
- **src600**
- **Folder containing the kernel source**
- **RI600V4 kernel relation**
  - Sample project folder for CS+
- **Plug-in relation for CS+**
1.4.4 RI600PX

The following shows the folder configuration when the files stored in the RI600PX distribution media have been installed.

**Figure 1-7. Folder Configuration (Object Release Version) [RI600PX]**

![Diagram of folder configuration for Object Release Version]

**Figure 1-8. Folder Configuration (Source Release Version) [RI600PX]**

![Diagram of folder configuration for Source Release Version]
The following shows the folder configuration when the files stored in the RI850V4 V1.xx.xx distribution media have been installed.

**Figure 1-9. Folder Configuration (Object Release Version) [RI850V4 V1.xx.xx]**

```plaintext
Renewal Electronics\CS+\CACX

- Documents
- Help
- RI850V4
  - bin
  - include
  - library
    - v850e_ca
      - r22
      - r26
      - r32
    - v850e_ghs
      - r22
      - r26
      - r32
    - v850e2m_cx
      - r22
      - r26
      - r32
    - v850e2m_ghs
      - r22
      - r26
      - r32
- sample
  - v850e_ghs
  - v850e2m_ghs

- Documents
- Online help file for the RI850V4
- RI850V4 kernel relation
- Executable file of configurator
- Header files for the RI850V4
- Library files for the RI850V4
- Kernel library for CA850
- 22-register mode
- 26-register mode
- 32-register mode
- Kernel library for Green Hills Compiler
- 22-register mode
- 26-register mode
- 32-register mode
- Kernel library for CX [V850E2M]
- 22-register mode
- 26-register mode
- 32-register mode
- Kernel library for Green Hills Compiler [V850E2M]
- 22-register mode
- 26-register mode
- 32-register mode
- Sample project folder for RI850V4
- Sample project folder for Green Hills Software
- Sample project folder for Green Hills Software [V850E2M]
AZ850V4
  └── bin
     └── Program analyzer relation
  └── hlp
     └── Executable file of program analyzer
  └── lib850
      └── Online help file for program analyzer
          └── Object files of AZ monitor
              └── 22-register mode
              └── 26-register mode
              └── 32-register mode
  └── smp850
      └── Sample program of user-own coding module for AZ monitor
          └── 22-register mode
          └── 26-register mode
          └── 32-register mode

Plugins
  ├── RtosBuild
  │   └── Plug-in relation for CS+
  │       └── Plug-in for real-time OS build setting
  ├── RtosControl
  │   └── Plug-in for real-time OS analysis control
  │       └── Plug-in for real-time OS resource information display
  │       └── Sample project folder for CS+
  └── RtosResource
      └── Plug-in for real-time OS resource information display
          └── Sample project folder for CS+
          └── Sample project folder for CS+
Figure 1-10. Folder Configuration (Source Release Version) [RI850V4 V1.xx.xx]

Renesas Electronics\CS+\CACX

Documents

Help

RI850V4

bin

include

library

v850e_ca

| r22 | 22-register mode |
| r26 | 26-register mode |
| r32 | 32-register mode |

v850e_ghs

| r22 | 22-register mode |
| r26 | 26-register mode |
| r32 | 32-register mode |

v850e2m_cx

| r22 | 22-register mode |
| r26 | 26-register mode |
| r32 | 32-register mode |

v850e2m_ghs

| r22 | 22-register mode |
| r26 | 26-register mode |
| r32 | 32-register mode |

sample

v850e_ghs

Sample project folder for Green Hills Software

v850e2m_ghs

Sample project folder for Green Hills Software [V850E2M]

source

project

v850e_ca

| r22 | 22-register mode |
| r26 | 26-register mode |
| r32 | 32-register mode |

Folder containing the project file for building the kernel source

Renesas Electronics\CS+\CACX

Documents

Online help file for the RI850V4

RI850V4 kernel relation

Executable file of configurator

Header files for the RI850V4

Library files for the RI850V4

v850e_ca

Kernel library for CA850

r22

22-register mode

r26

26-register mode

r32

32-register mode

v850e_ghs

Kernel library for Green Hills Compiler

r22

22-register mode

r26

26-register mode

r32

32-register mode

v850e2m_cx

Kernel library for CX [V850E2M]

r22

22-register mode

r26

26-register mode

r32

32-register mode

v850e2m_ghs

Kernel library for Green Hills Compiler [V850E2M]

r22

22-register mode

r26

26-register mode

r32

32-register mode

sample

v850e_ghs

Sample project folder for RI850V4

v850e2m_ghs

Sample project folder for Green Hills Software [V850E2M]
v850e_ghs ➔ Project file for Green Hills Compiler
  r22 ➔ 22-register mode
  r26 ➔ 26-register mode
  r32 ➔ 32-register mode

v850e2m_cx ➔ Project file for CX [V850E2M]
  r22 ➔ 22-register mode
  r26 ➔ 26-register mode
  r32 ➔ 32-register mode

v850e2m_ghs ➔ Project file for Green Hills Compiler [V850E2M]
  r22 ➔ 22-register mode
  r26 ➔ 26-register mode
  r32 ➔ 32-register mode

kernel ➔ Folder containing the kernel source

AZ850V4 ➔ Program analyzer relation
  bin ➔ Executable file of program analyzer
  hlp ➔ Online help file for program analyzer
  lib850 ➔ Object files of AZ monitor
    r22 ➔ 22-register mode
    r26 ➔ 26-register mode
    r32 ➔ 32-register mode

smp850 ➔ Sample program of user-own coding module for AZ monitor

Plugins ➔ Plug-in relation for CS+
  RtosBuild ➔ Plug-in for real-time OS build setting
  RtosControl ➔ Plug-in for real-time OS analysis control
  RtosResource ➔ Plug-in for real-time OS resource information display

SampleProjects ➔ Sample project folder for CS+
1.4.6 RI850MP

The following shows the folder configuration when the files stored in the RI850MP distribution media have been installed.

Figure 1-11. Folder Configuration (Object Release Version) [RI850MP]

Renesas Electronics\CS+/CACX

- Documents
- Help
- RI850MP
  - bin
  - include
  - library
    - v850e2m_cx
      - r32
    - v850e_ghs
      - r32
  - sample
    - v850e2m_ghs
  - source
    - project
    - iflibrary
- Plugins
  - RtosBuild
  - RtosControl
  - RtosResource
- SampleProjects

- Documents
- Online help file for the RI850MP
- RI850V4 kernel relation
- Executable file of configurator
- Header files for the RI850MP
- Library files for the RI850MP
- Kernel library for CX
- 32-register mode
- Kernel library for Green Hills Compiler
- 32-register mode
- Sample project folder for RI850MP
- Sample project folder for Green Hills Software [V850E2M]
- Folder containing the project file for building the interface library source
- Folder containing the source file of the interface library
- Plug-in relation for CS+
- Plug-in for real-time OS build setting
- Plug-in for real-time OS analysis control
- Plug-in for real-time OS resource information display
- Sample project folder for CS+
Figure 1-12. Folder Configuration (Source Release Version) [RI850MP]

- **Documents**
  - Online help file for the RI850MP
  - RI850V4 kernel relation
  - Executable file of configurator
  - Header files for the RI850MP
  - Library files for the RI850MP

- **RI850MP**
  - **bin**
    - **include**
      - **library**
        - **v850e2m_cx**
          - **r32**
        - **v850e_ghs**
          - **r32**
  - **sample**
    - **v850e2m_ghs**
  - **source**
    - **project**
      - **v850e2m_rel**
        - **r32**
      - **v850e2m_ghs**
        - **r32**
  - **library**
  - **kernel**

- **Plugins**
  - **RtosBuild**
  - **RtosControl**
  - **RtosResource**

- **SampleProjects**
1.4.7 RI78V4 V1.xx.xx

The following shows the folder configuration when the files stored in the RI78V4 V1.xx.xx distribution media have been installed.

Figure 1-13. Folder Configuration (Object Release Version) [RI78V4 V1.xx.xx]
Figure 1-14. Folder Configuration (Source Release Version) [RI78V4 V1.xx.xx]

- **Documents**
  - Online help file for the RI78V4 V1.xx.xx
  - RI78V4 kernel relation
  - Executable file of configurator
  - Header files for the RI78V4 V1.xx.xx
  - Library files for the RI78V4 V1.xx.xx
  - Library files for the RL78/78K0R
  - large model

- **Help**
  - Executable file of program analyzer
  - Online help file for program analyzer

- **RI78V4**
  - **bin**
  - include
  - library
    - r78_ca
    - large
  - source
    - **project**
    - r78_ca
    - large
  - kernel
  - **AZ78K0R**
    - **bin**
    - hlp

- **AZ78K0R**

- **Plugins**
  - RtosBuild
  - RtosControl
  - RtosResource

- **SampleProjects**
  - Plug-in relation for CS+
  - Plug-in for real-time OS build setting
  - Plug-in for real-time OS analysis control
  - Plug-in for real-time OS resource information display
  - Sample project folder for CS+
1.5 Execution Environment

The following shows hardware required for the RI series to perform processing.

(1) CPU

The following shows CPU required for the RI series to perform processing.
- RL78 family [RI78V4 V2.xx.xx] [RI78V4 V1.xx.xx]
- RH850 family (G3K/G3M/G3KH/G3MH core) [RI850V4 V2.xx.xx]
- RX family (RX100/RX200 core) [RI600V4]
- RX family (RX600 core) [RI600V4][RI600PX]
- V850 family (V850ES/V850E1/V850E2/V850E2M core) [RI850V4 V1.xx.xx]
- V850 family equipped with two V850E2M cores [RI850MP]
- 78K0R microcontrollers [RI78V4 V1.xx.xx]

(2) Peripheral controller

To support various execution environments, the RI series extracts hardware-dependent processing as user-own coding module and target-dependent modules, provides it as sample source files. Because the execution environment is supported just by rewriting the user-own coding module and target-dependent modules according to the environment, special peripheral controllers are not required.

Controllers such as a clock controller are required to use the time management functions provided by the RI series, or controllers such as an interrupt controller are required to use the interrupt management functions.

(3) Memory capacity

The following shows the memory capacity required for the RI series to perform processing.
Regarding the figures listed below, the required memory capacity can be minimized by setting limits on the total number of definitions of OS resource-related information defined during configuration and the types of service calls that are used by the system.
- RI78V4 V2.xx.xx
  - ROM area: 3 KB or more
  - RAM area: 1 KB or more
- RI850V4 V2.xx.xx
  - ROM area: 5.5 KB or more
  - RAM area: 1.1 KB or more
- RI600V4
  - ROM area: 6 KB or more
  - RAM area: 1 KB or more
- RI600PX
  - ROM area: 7 KB or more
  - RAM area: 1 KB or more
- RI850V4 V1.xx.xx
  - ROM area: 6 KB or more
  - RAM area: 1 KB or more
- RI850MP
  - ROM area: 6 KB or more
  - RAM area: 1 KB or more
- RI78V4 V1.xx.xx
  - ROM area: 1 KB or more
  - RAM area: 1 KB or more
(4) Supported debug tool

Below is described the environment necessary for running the resource information tool and program analyzer tool/task analyzer tool.

Table 1-1. Supported Resource Information Display Tool

<table>
<thead>
<tr>
<th>Debug Tools</th>
<th>RI78V4 V2.xx.xx</th>
<th>RI850V4 V2.xx.xx</th>
<th>RI600V4</th>
<th>RI600PX</th>
<th>RI850V4 V1.xx.xx</th>
<th>RI850MP</th>
<th>RI78V4 V1.xx.xx</th>
</tr>
</thead>
<tbody>
<tr>
<td>IECUBE</td>
<td>OK</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
<td>OK</td>
<td>NG</td>
<td>OK</td>
</tr>
<tr>
<td>IECUBE2</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
<td>OK</td>
<td>NG</td>
<td>NG</td>
</tr>
<tr>
<td>MINICUBE</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
<td>OK</td>
<td>OK</td>
<td>NG</td>
</tr>
<tr>
<td>MINICUBE2</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
<td>OK</td>
<td>NG</td>
<td>OK</td>
</tr>
<tr>
<td>E1</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>E20</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>EZ Emulator</td>
<td>NG</td>
<td>NG</td>
<td>OK</td>
<td>NG</td>
<td>OK</td>
<td>NG</td>
<td>OK</td>
</tr>
<tr>
<td>Simulator</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
<td>NG</td>
<td>OK</td>
</tr>
</tbody>
</table>

OK: It can be used by this combination.
NG: It can't be used by this combination.

Table 1-2. Supported Program Analyze Tool

<table>
<thead>
<tr>
<th></th>
<th>RI850V4 V1.xx.xx</th>
<th>RI78V4 V1.xx.xx</th>
</tr>
</thead>
<tbody>
<tr>
<td>IECUBE</td>
<td>OK</td>
<td>OK Note 1</td>
</tr>
<tr>
<td>IECUBE2</td>
<td>OK</td>
<td>NG</td>
</tr>
<tr>
<td>MINICUBE</td>
<td>OK Note 2</td>
<td>NG</td>
</tr>
<tr>
<td>MINICUBE2</td>
<td>OK Note 2</td>
<td>NG</td>
</tr>
<tr>
<td>E1</td>
<td>OK Note 2</td>
<td>NG</td>
</tr>
<tr>
<td>E20</td>
<td>OK Note 2</td>
<td>NG</td>
</tr>
<tr>
<td>EZ Emulator</td>
<td>OK Note 2</td>
<td>NG</td>
</tr>
<tr>
<td>Simulator</td>
<td>OK</td>
<td>OK Note 1</td>
</tr>
</tbody>
</table>

OK: It can be used by this combination.
NG: It can't be used by this combination.

Notes 1. It can be used only by a hardware trace mode. It can't be used by a software trace mode.
2. It can be used only by a software trace mode. It can't be used by a hardware trace mode.
### Table 1-3. Supported Task Analyzer Too

<table>
<thead>
<tr>
<th></th>
<th>RI78V4 V2.xx.xx</th>
<th>RI850V4 V2.xx.xx</th>
<th>RI600V4</th>
</tr>
</thead>
<tbody>
<tr>
<td>IECUBE</td>
<td>OK</td>
<td>NG</td>
<td>NG</td>
</tr>
<tr>
<td>IECUBE2</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
</tr>
<tr>
<td>MINICUBE</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
</tr>
<tr>
<td>MINICUBE2</td>
<td>NG</td>
<td>NG</td>
<td>NG</td>
</tr>
<tr>
<td>E1</td>
<td>OK&lt;sup&gt;Note 1&lt;/sup&gt;</td>
<td>OK&lt;sup&gt;Note 2&lt;/sup&gt;</td>
<td>OK&lt;sup&gt;Note 2&lt;/sup&gt;</td>
</tr>
<tr>
<td>E20</td>
<td>OK&lt;sup&gt;Note 1&lt;/sup&gt;</td>
<td>OK</td>
<td>OK</td>
</tr>
<tr>
<td>EZ Emulator</td>
<td>NG</td>
<td>NG</td>
<td>OK&lt;sup&gt;Note 1&lt;/sup&gt;</td>
</tr>
<tr>
<td>Simulator</td>
<td>OK</td>
<td>OK</td>
<td>OK</td>
</tr>
</tbody>
</table>

**OK**: It can be used by this combination.

**NG**: It can't be used by this combination.

**Notes**

1. It can be used only by a software trace mode. It can't be used by a hardware trace mode.
2. The acquisition of trace information is limited to a maximum of 256 cycles in hardware trace mode.
This chapter describes how to install the real-time OS package, and how to start tools provided by it.

2.1 Installing Real-time OS Package

This section describes how to install real-time OS package.

(1) Insert the CD-ROM into the drive.

The Preparing to Install page appears automatically.

After, please operate with displayed contents.

Remark

If the page does not appear automatically, open "Install.hta" in the CD-ROM.
2.2 Uninstalling Real-time OS Package

You can uninstall real-time OS package using the CS+ Uninstaller.

From the Windows [Start] menu, select [Programs] >> [Renesas Electronics CS+] >> [CS+ Uninstaller]. The uninstallation begins.

![Figure 2-2. CS+ Uninstaller Window](image)

The CS+ Uninstaller window looks up all CS+ products and real-time OS package products you have installed, and displays them in a list of check boxes.

Click [Select all] to select all the check boxes.
Click [Unselect all] to clear all the check boxes.
Click [Uninstall] to uninstall the selected products.

**Caution** If all products are uninstalled, the CS+ Uninstaller will be also uninstalled automatically.

2.3 Create a Project for RI Series

The creation of a project for RI series is performed with the Create Project dialog box (See the CS+ Integrated Development Environment User's Manual: Start "2.6.2 Create a new project"). From the [Project] menu, select [Create New Project...], the following dialog box will open.

Figure 2-3. Create Project Dialog Box

Select the item below on [Kind of project].
- Application (RI series name, Build tool name)
  Select this to generate a project for RI series.
2.4 Convert a CubeSuite Project into a CS+ Project

In the RI series, you can convert a CubeSuite project into a CS+ project automatically by selecting [Open Project...] from the [Project] menu with CS+.
- The real-time OS name in use will be changed at the same time (RX78K0R -> RI78V4 V1.xx.xx, RX850V4 -> RI850V4 V1.xx.xx)
- With the change of the real-time OS name, substitution processing will be performed for the following: system configuration file that was used in a CubeSuite project; real-time OS name described in the link directive file; version; and memory area
- Since substitution processing will be performed on your system configuration file and link directive file, backup copies of the original files will first be made. Name the copied file as original-file-name.(dot)old-real-time-OS-name.
- Because substitution processing will be performed, do not add a write inhibit attribute to any file or folder to be converted. If it has a write inhibit attribute, no substitution processing will be performed.
- The character code of the file generated after substitution will be the same as the character code before substitution. If the character code cannot be identified, the Windows default character code will be used.
- After processing of conversion to CS+, output (rebuild) again the file generated from the system configuration file.

Caution It cannot convert a project directly “RX78K0R -> RI78V4 V2.xx.xx” or “RX850V4 -> RI850V4 V2.xx.xx”. In this case, first, converts project “RX78K0R -> RI78V4 V1.xx.xx’ or “RX850V4 -> RI850V4 V1.xx.xx”, next, uses project diversion function.

2.5 Convert a HEW Project into a CS+ Project

When a HEW (hereafter abbreviated “HEW”) project is loaded, if the real-time OS was in use in that project, then it will be reflected in the properties of the build tool.

The real-time OS settings in the HEW project are shown below.

2.6 Convert a Project “RI78V4 V1.xx.xx -> V2.xx.xx” or “RI850V4 V1.xx.xx -> V2.xx.xx”

When converting a project of “RI78V4 V1.xx.xx” or “RI850V4 V1.xx.xx” to a project of “RI78V4 V2.xx.xx” or “RI850V4 V2.xx.xx”, you convert using “the project diversion function”. In other words, you make a project of “RI78V4 V1.xx.xx” or “RI850V4 V1.xx.xx” the diversion subject, choose “RI78V4 V2.xx.xx” or “RI850V4 V2.xx.xx” as the kind of made projects and make a project. In detail, please refer to the manual “CS+ Project Operation”.
2.7 Start Resource Information Tool

When a program using the real-time OS feature is downloaded, the Realtime OS Resource Information panel is opened automatically.

From [View] menu, select [Realtime OS] >> [Resource Information]. The Realtime OS Resource Information panel opens.

Figure 2-4. [Resource Information] Item
**Figure 2-5. Realtime OS Resource Information Panel**

<table>
<thead>
<tr>
<th>Resource Information</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RTOS Name</td>
<td>RI78V4</td>
</tr>
<tr>
<td>Version</td>
<td>V2.00.00</td>
</tr>
<tr>
<td>System Time</td>
<td>000000</td>
</tr>
<tr>
<td>Interrupt Nest</td>
<td>000000</td>
</tr>
<tr>
<td>Dispatching</td>
<td>Enable</td>
</tr>
<tr>
<td>CPU Lock</td>
<td>Unlocked</td>
</tr>
<tr>
<td>System Stack Area</td>
<td>1016084 - 1016366 (232)</td>
</tr>
<tr>
<td>Current System SP</td>
<td>1016366</td>
</tr>
<tr>
<td>Idle Routine Start Address</td>
<td>_idle_handler (55559)</td>
</tr>
<tr>
<td>Number of Priority</td>
<td>15</td>
</tr>
<tr>
<td>Number of Task</td>
<td>1</td>
</tr>
<tr>
<td>Number of Semaphore</td>
<td>0</td>
</tr>
<tr>
<td>Number of Eventflag</td>
<td>0</td>
</tr>
<tr>
<td>Number of Data Queue</td>
<td>0</td>
</tr>
<tr>
<td>Number of Mailbox</td>
<td>0</td>
</tr>
<tr>
<td>Number of Mutex</td>
<td>-</td>
</tr>
<tr>
<td>Number of Message Buffer</td>
<td>-</td>
</tr>
<tr>
<td>Number of Fixed-Sized Memory Pool</td>
<td>0</td>
</tr>
<tr>
<td>Number of Variable-Sized Memory Pool</td>
<td>-</td>
</tr>
<tr>
<td>Number of Cyclic Handler</td>
<td>0</td>
</tr>
<tr>
<td>Number of Alarm Handler</td>
<td>0</td>
</tr>
<tr>
<td>Number of Interrupt Handler</td>
<td>0</td>
</tr>
<tr>
<td>Number of Initialize Routine</td>
<td>1</td>
</tr>
<tr>
<td>Number of Extended Service Call Routine</td>
<td>-</td>
</tr>
</tbody>
</table>

**Remarks 1.**
When resource information tool has started, it isn't possible to start more resource information tool.

**Remarks 2.**
2.8 Start Task Analyzer Tool [RI78V4 V2.xx.xx][RI850V4 V2.xx.xx][RI600V4]

From [View] menu, select [Realtime OS] >> [Task Analyzer 1] or [Task Analyzer 2]. The Realtime OS Task Analyzer panel opens.

Figure 2-6. [Task Analyzer] Item
Remarks 1. Up to two panels can be opened by the task analyzer tool: the Realtime OS Task Analyzer1 panel and the Realtime OS Task Analyzer2 panel.

2.9 Start Program Analyzer Tool [RI850V4 V1.xx.xx][RI78V4 V1.xx.xx]

From [View] menu, select [Realtime OS] >> [Program Analyzer], program analyzer is started.
From [View] menu, select [Realtime OS] >> [Program Analyzer]. The program analyzer is started.

Figure 2-8. [Program Analyzer] Item
Figure 2-9. Program Analyzer Window

Remarks 1. When program analyzer has started, it isn't possible to start more program analyzer.

This appendix describes the windows related to tools offered in the real-time OS package.

A.1 Description

Below is a list of the windows related to tools offered in the real-time OS package.

<table>
<thead>
<tr>
<th>Table A-1. Window/Panel/Dialog Box List</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Window/Panel/Dialog Box Name</strong></td>
</tr>
<tr>
<td>Main window</td>
</tr>
<tr>
<td>Create Project dialog box</td>
</tr>
<tr>
<td>Project Tree panel</td>
</tr>
<tr>
<td>Property panel</td>
</tr>
<tr>
<td>Realtime OS Resource Information panel</td>
</tr>
<tr>
<td>Realtime OS Task Analyzer panel</td>
</tr>
<tr>
<td>Program analyzer window (AZ850V4 window) [RI850V4 V1.xx.xx]</td>
</tr>
<tr>
<td>Program analyzer window (AZ78K0R window) [RI78V4 V1.xx.xx]</td>
</tr>
</tbody>
</table>
This is the start-up window that opens when CS+ is launched. In this window, you can control the user program execution and open panels.

**Figure A-1. Main Window**

The following items are explained here.
- [How to open]
- [Description of each area]

**How to open**
- Select Windows [Start] >> [Programs] >> [Renesas Electronics CS+] >> [CS+].

**Description of each area**

1. **Menu bar**
   - This displays menus about real-time OS package.
   - **[View]**
### Toolbar

The toolbar shows command buttons relating to real-time OS package.

<table>
<thead>
<tr>
<th>Realtime OS</th>
<th>Displays a cascading menu for relating to real-time OS package.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resource Information</td>
<td>Opens the Realtime OS Resource Information panel.</td>
</tr>
<tr>
<td>Program Analyzer</td>
<td>Program analyzer is started. [RI850V4 V1.xx.xx] Opens the AZ850V4 window. [RI78V4 V1.xx.xx] Opens the AZ78K0R window.</td>
</tr>
<tr>
<td>Task Analyzer 1</td>
<td>Opens the Realtime OS Task Analyzer 1 panel. [RI78V4 V2.xx.xx][RI850V4 V2.xx.xx][RI600V4]</td>
</tr>
<tr>
<td>Task Analyzer 2</td>
<td>Opens the Realtime OS Task Analyzer 2 panel. [RI78V4 V2.xx.xx][RI850V4 V2.xx.xx][RI600V4]</td>
</tr>
</tbody>
</table>

### Panel display area

Panels are displayed in this area.
<table>
<thead>
<tr>
<th>Rev.</th>
<th>Date</th>
<th>Page Summary</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>Oct 01, 2011</td>
<td>-</td>
<td>First Edition issued</td>
</tr>
<tr>
<td>1.01</td>
<td>Apr 01, 2012</td>
<td>7, 8, 10, 16, 17, 26, 27, 41</td>
<td>Added the following: RI600PX</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7, 19, 21, 24, 25, 27, 39, 40, 41, 43</td>
<td>Changed as follows: Performance analyzer -&gt; Program analyzer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9</td>
<td>1.3.1 RI600V4 Added the following: &quot;(2) User-own coding module&quot; - &quot;System initializing process&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Section information</td>
</tr>
<tr>
<td>1.02</td>
<td>Sep 01, 2012</td>
<td>7</td>
<td>1.2 Features Added the following: &quot;(4) Support tools related to real-time OS&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14, 15</td>
<td>1.4.1 RI600V4 Added the following: &quot;Figure 1-1. Folder Configuration (Object Release Version) [RI600V4]&quot;, &quot;Figure 1-2. Folder Configuration (Source Release Version) [RI600V4]&quot; Plug-in for task analyzer tool</td>
</tr>
<tr>
<td></td>
<td></td>
<td>27</td>
<td>1.5 Execution Environment Added the following: &quot;Table 1-1. Supported Debug Tool&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>39</td>
<td>Added the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2.7 Start Task Analyzer Tool [RI600V4]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>43</td>
<td>A.1 Description Added the following: &quot;Table A-1. Window/Panel/Dialog Box List&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Task analyzer panel [RI600V4]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>45</td>
<td>Main window Added the following: &quot;[Description of each area]&quot; - &quot;(1) Menu bar&quot;, &quot;(2) Toolbar&quot; Description of the task analyzer tool</td>
</tr>
<tr>
<td>1.03</td>
<td>Mar 03, 2014</td>
<td>-</td>
<td>Added the &quot;RI850V4 V2.xx.xx&quot;</td>
</tr>
<tr>
<td>Rev.</td>
<td>Date</td>
<td>Page</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>--------------</td>
<td>------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1.04</td>
<td>Mar 25, 2015</td>
<td>1</td>
<td>Added the “RI78V4 V2.xx.xx”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2</td>
<td>Changed the “CubeSuite+” to “CS+”</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3</td>
<td>Changed the image for CS+</td>
</tr>
<tr>
<td>1.05</td>
<td>Sep 30, 2015</td>
<td>18</td>
<td>Added the folder for Green Hills Software to “Folder Configuration (Object Release Version [RI850V4 V2.xx.xx]“</td>
</tr>
<tr>
<td></td>
<td></td>
<td>19</td>
<td>Added the folder for Green Hills Software to “Folder Configuration (Source Release Version [RI850V4 V2.xx.xx]“</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30</td>
<td>Changed the description as following</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RH850 Family</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RH850 Family (G3K/G3M core)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>30</td>
<td>Changed the description as following</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RX family (RX200 core) [RI600V4]</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RX family (RX100/RX200 core) [RI600V4]</td>
</tr>
<tr>
<td>1.06</td>
<td>Jan 29, 2016</td>
<td>30</td>
<td>Changed the description as following</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RH850 Family(G3K/G3M core)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>-&gt;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- RH850 Family (G3K/G3M/G3KH/G3MH core)</td>
</tr>
</tbody>
</table>